� View2 ™Window Organizer for Word


DESIGNED FOR WORD 6 FOR WINDOWS & WORD 7 FOR WINDOWS 95 OR WINDOWS NT


� MACROBUTTON View2Test Double-Click Here to Test View2 �





� MACROBUTTON View2Install Double-Click Here to Install View2 �


This automatic installation transfers View2 to your Normal template, puts a View2 button on your Standard toolbar, creates a View2 command in your Window menu, and assigns a shortcut key (alt+shift+v). If the installation is not successful for any reason, you can do it yourself (explained below).


NEW!


�
� EMBED Package  ����
Double-click on the icon�to preview View2





PC World’s May 1995 survey of “Software for Next to Nothing” features View2 among the 28 top programs available for $20 or less. 


In fact, View2 is yours for nothing! It’s Free and always will be. That means you can use and distribute it guilt-free!





Please register�
� EMBED Package  ���


�
Double-click on the icon


VIEW2 (Revision 5.1) Release Notes	12/1/95


What View2 can do for you?


Word 6 and 7, the most powerful word processors in the world, have something serious missing—you can’t do side-by-side editing automatically and conveniently. View2 makes it easy for you to exploit to the full the value of Word’s multiple document interface:


If you find yourself frequently switching documents windows to compare and edit files, then View2 is for you.


If you want to make detailed comparisons of different documents the way you would with paper documents—namely, side by side—then View2 is for you.


If you want to write in Normal view and, at the same time, see a copy of your document take shape in page layout or outline view, then View2 is for you. 


If you want to work in different parts of the same document at the same time, then View2 is for you.


Word must have something like this?


No. It has the Arrange All command that arranges all your open documents so they do not overlap. The problem with this is that you have no control over the way the documents are arranged. It’s only useful if you have a couple of windows open and, only then, if you’re happy “up-and-down” editing.


Word 6 does supply a macro in the layout.dot template called ArrangeWindows that has a horizontal or vertical option. (You can check it out by loading layout.dot as a global template or transferring the macro to the template you are working in.)


There are three things about this macro that make it virtually useless:


It does not let you specify which document windows to arrange.


It does not wrap the text in each document window for side-by-side editing.


It does not size the windows properly if the Zoom magnification is less or greater than 100%.


View2 instructions


View2 is self-explanatory and uses dynamic controls and text to guide you. There’s a built-in Help panel also. 





Here are a few pointers to guide you:


The file name you see above the list box is your active document. It’s also the document that is initially selected in the list box.


The documents you see in the list box are the same ones you can see at the bottom of your Window menu: they’re listed in just the same order, which is alphabetical.


When you select a document in the list box, its name is displayed beneath the list box with the choices about how to display it. When you choose OK it is displayed with your active document.


By default, documents are arranged vertically; you choose to put the document you select on either side of the active document with the Left and Right options beneath the list box.


Alternatively, you can select the Horizontal arrange option, and choose to put the document you select above or below the active one with the Top and Bottom options beneath the list box.


If you leave your active document selected in the list box, you can choose to maximize it or view it twice with the Max. and Twice options beneath the list box. When Max. is selected the Vertical and Horizontal options are not available.


You can make any window the active document by selecting it from the list and choosing Activate. Its window is activated, and its name appears above the list.


If the documents you want to arrange are not in the list box, you can open any file you want with the Open File button. When you open a file it becomes the active document automatically and is displayed without closing View2.


There is also a Close File button that makes it easy to close extra windows or unwanted files quickly without closing View2. 


There is a three-way toggle button that first lets you arrange all your open documents (View All), then lets you minimize all your documents (Min. All), and then lets you maximize all your documents (Max. All). When you use the toggle button, the dialog box remains open.


When you open or close a file, activate a window, or toggle the view, the Cancel button becomes a Close button, indicating that this choice is not reversed by canceling the dialog box.


What does View2 do to my documents?


View2 puts the documents you select into normal view and zooms them to 100%. You can then switch to another view and zoom the document magnification as you want. (Each window—and if you split the windows, each pane—can be in a different view and have a different magnification.)


When you arrange documents vertically, View2 automatically wraps the text in each window for easy editing. Here are two questions that people sometimes ask:


What happened to my line numbers?�Word doesn’t show line numbers on the status bar when text is wrapped.


Why does my text seem longer than before?�Word is wrapping the text to the edge of the window when you’re working full-screen.


Solution:�Run View2 again and choose OK (when the Max. option is selected).


The Max. option maximizes all your open windows and unwraps their texts. Remember to use this command when you’re ready to work full-screen. (If you maximize a window without using View2 that you previously arranged vertically, the text remains wrapped.)


View2 has no effect on the configuration of your Word desktop or your documents. Window sizing and text wrapping are display features that have no effect on the formatting of the documents themselves.


Tips


If you find your text is wrapping to the end of a maximized window in normal View, you can just reopen View2 and choose OK. Make a habit of doing this when you finish editing side by side. This will return the text wrapping to normal in all your open documents..


Word windows “remember” their previous size and position. You may notice that choosing the restore button on a window puts it back to just the same position you set for it in View2—even after maximizing all your windows. You can use this to your advantage by restoring and maximizing windows without having to reposition them with View2.


Use the power View2 gives you to work in two views of the same document by using the Twice option. This is a very powerful feature because it lets you build and examine the same document in two different perspectives. It’s far more effective that splitting a window horizontally, where the two panes are not truly independent—for example, switching views or scrolling in one pane affects the other pane. But remember that you are still working on one document, and that editing in one window is the same as editing in the other.


If you use View2 when working in outline or page layout view and you have more or fewer toolbars in one of these views than your normal view, the windows will be sized according to this toolbar arrangement. Either they will appear with a gap at the bottom, or the bottom of the windows will be hidden behind the status bar. When you return to outline or page layout view the Windows will be sized correctly.


Manual installation of View2


Here are step-by-step instructions if the automated installation failed or you want to change part of it. If you know how to copy macros to different templates, customize your toolbars and menus, and assign shortcuts, you don’t need to read this.


How to install View2:


You need to put the View2 macro in the template you use when working in Word. If you put it in your Normal template, it will always be available, even when you work in another template (such as Letter1 or Memo2).


Move or copy this file, VIEW251.DOC, to the template subdirectory of winword.


Choose Templates from the File menu. Then choose the Organizer button in the Templates and Add-ins dialog box.�or�Choose Macro from the Tools menu. Then choose the Organizer button in the Macro dialog box.


Select the Macro tab of the Organizer dialog box.


Select the normal.dot template in one list box and the VIEW251.DOC template in the other. To do this:


Click one of the Close File buttons twice and browse for VIEW251.DOC in the Open dialog box.


Choose OK when you’ve selected it.�You should see the View2 macro in the list box for VIEW251.DOC.


Select it and choose Copy.�View2 should now appear in the normal.dot list box (or whichever template you selected).


Now you can create:


a button for View2 on a toolbar


add it to a menu


create a shortcut key


To create a button for View2:


Choose Customize from the Tools menu.


Select the Toolbar tab from the Customize dialog box.


Select Macros from the Categories list.


Select View2 from the Macros list.�You’ll see a little frame by the pointer, which means you can drag it.


Drag the frame to the toolbar of your choice.�The frame becomes a blank button, and the Custom dialog box appears.


Select a button from the icon selection and choose assign.


If you don’t like any of them, choose Edit and draw your own icon or use one of the View2 icons that are stored as autotext entries in VIEW251.DOC.


To add View2 to a menu:


Select the toolbar tab from the Customize dialog box.


If View2 isn’t already selected, select Macros from the Categories list and View2 from the Macros list.


Below the list box there are three drop-down lists:


Select which menu you want to add the View2 command to.�(I recommend your Window menu.)


Then select where you want it to appear in the menu.


Then select how you want it to read on the menu.�(The ampersand before the name tells Word to put an underline under the first letter—giving you keyboard access from the menu.)


Choose add when you’re ready.


To create a shortcut for View2:


Select the Keyboard tab from the Customize dialog box.


If View2 isn’t already selected, select Macros from the Categories list and View2 from the Macros list.


Press a combination of keys and see if it’s available. When you find one that is, choose Assign.


Close the Customize dialog box.


As a precaution, save your template by choosing Save All from the File menu. You’re all set now and ready to use View2.





Revision History


There have now been six versions/revisions of View2 since it was released one year ago:


Version 1�Side-by-side placement of document windows using a dynamic dialog box.


Version 2�Side-by-side and up-and-down placement of document windows and on-the-fly document switching. 


Version 3�Ability to make a selected document the active one, plus file open and close capabilities.


Version 4�Ability to distinguish between identically named documents in different directories.


Revision 5�Redesigned to be fully functional in Word 7 as well as Word 6.


Revision 5.1 (Current)�Enables opening of multiple files in Word 7 (available in Word 6 since Version 4). The number of files you can open at one time (by choosing File|Open File) is dependent on the length of the file names. The total length of the selected file names cannot exceed 255 characters due to a limitation of WordBasic. (Thanks go to Romke Soldaat for showing how to do this.)


Restores minimized document windows when switching.





View2 is freeware. Install it, use it, and give it to other Word users. If you think it’s a worthwhile addition to the Word interface, let me know and let Microsoft know too! Your comments or suggestions are always welcome when you register at e-mail: mross@adpt.co.il or CompuServe ID: 100274,2520 using the attached text file.





Patent Pending in the U.S. 


Copyright © 1995 by Michael M. Ross. All rights reserved.


View2 and View2 Plus are trademarks of Michael M. Ross.


All other trademarks are the property of their respective holders.














